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1. System configuration 

The system configuration of TOP and “X-SEL Controller” is as follows: 

 

Series CPU Link I/F 
Communication 

method 
System setting Cable 

X-SEL Series RS-232C 
3.1 Settings example 1 

(Page 4) 

5.1. Cable table 1 

(Page 9) 

 

■ Connectable configuration 

ㆍ1:1 connection 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 
 

 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “M2I Corporation”. 

PLC Select an external device to connect to TOP. 
 

Model Interface Protocol 

X-SEL Series Serial Private Protocol 
 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 



 

 

External device connection manual for TOP Design Studio 4 / 17 

3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [Project > Project Property > TOP Setting] → [HMI Setup > “Use HMI Setup” Check > Edit > Serial] 

– Set the TOP communication interface in TOP Design Studio. 

 
 

 
 

Items TOP External device Remarks 

Signal Level RS-232C RS-232C  

Baud Rate 9600  

Data Bit 8  

Stop Bit 1  

Parity Bit none  

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [Project > Project Property > Device Setting > COM > “PLC1 : X-SEL Series”] 

– Set the options of the X-SEL Series communication driver in TOP Design Studio. 

 

 

Items Settings Remarks 

Interface Select Serial.  

Protocol Select Private Protocol.  

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device and 

sending the next command request. 
 

Retry Configure the amount of redelivery attempts made by the external device to TOP.  
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3.2. Communication setting in TOP  

* This is a setting method when "Use HMI Setup" in the setting items in "3.1 TOP Design Studio" is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [Main Screen > Control Panel > Serial]  
 

 

Items TOP External device Remarks 

Signal Level RS-232C RS-232C  

Baud Rate 9600  

Data Bit 8  

Stop Bit 1  

Parity Bit none  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [Main Screen > Control Panel > PLC] 
 

 

Items Settings Remarks 

Interface Select Serial.  

Protocol Select Private Protocol.  

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Retry Configure the amount of redelivery attempts made by the external device to TOP.  
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch "Communication diagnostics" in [Control Panel > PLC]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 

 

Configure the communication setting of the external device by referring to its user manual. 
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5. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 
 

■ 1:1 connection (RS-232C) 

 

TOP 

Cable 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

 

Based on 

communication 

cable  

connector front, 

D-SUB 9 Pin 

      

 
Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin 
 

RD 2 2 RD 

SD 3 3 SD 

    

SG 5 5 SG 

    

    

    

    

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
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6. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be careful not to deviate from the address 

range supported by the device you want to use.*Detailed description for the address can be found below.  

 

Device Bit Word Double word Description Remarks 

IP IP000 - IP287 IP000 - IP272 
 Input Port *1) 

OP OP300 - OP587 OP300 - OP572  Output Port  

FG 
FG000:600 - FG000:899 

FG001:900 - FG128:999 

FG000:600 - FG000:872 

FG001:900 - FG128:980 
━ Flag Data  

PDT ━ PDT0 ━ 
Number of Effective 

Point Data 

*1) 

*3) 

EPD ━ EPD0 ━ 
Number of Effective 

Point Data 2 

*1) 

*3) 

INT 
INT000:0200.0 - INT000:1299.31 

INT001:0001.0 - INT128:1099.31 

INT000:0200 - INT000:1299 

INT001:0001 - INT128:1099 

INT000:0200 - INT000:1299 

INT001:0001 - INT128:1099 
Integer Data  

RL ━ 
RL0000:0300 - RL0000:1399 

RL0001:0100 - RL0128:1199 

RL000.0300 - RL000.1399 

RL001.0100 - RL128.1199 
Real Data  

AXST AXST00.00 – AXST47.15 AXST00 - AXST47  Axis Status *1) 

PGST PGST000.00 - PGST511.15 PGST000 - PGST511  Program Status *1) 

SYST SYST0.00 - SYST6.15 SYST0 - SYST6  System Status *1) 

PRG ━ PRG000 - PRG128  Program Control *2) 

AR  AR0 ━ Alarm Reset *2) 

SR  SR0 ━ Software Reset *2) 

DSR  DSR0 ━ 
Drive-Source 

Recovery 
*2) 

OPR  OPR0 ━ 
Operation-Pause 

Cancellation 
*2) 

SV  SV0 - SV2 ━ Servo ON/OFF *2) 

RO  RO0 - RO3 ━ Home Return *2) 

ACM   ACM0 - ACMC 

Absolute Coordinate 

Specification 

Movement 

*2) 

RCM   RCM0 - RCMC 

Relative Coordinate 

Specification 

Movement 

*2) 

JIM   JIM0 - JIM6 Jogging/Inching *2) 

PNM  PNM0 - PNM5  

Point-Number 

Specification 

Movement 

*2) 

OSC  OSC0 - OSC2 ━ 
Operation 

Stop/Cancel 

*2) 

PD PD0001:00.00 - PD1500:12.31 PD0001:00 - PD1500:12 PD0001:00 - PD1500:12 Point Data *4) 

ED ED0001:00.00 - ED1500:12.31 ED0001:00 - ED1500:12 ED0001:00 - ED1500:12 Point Data 2 *4) 

PDO  PDO0 - PDO2  
Effective Point Data 

(Operate) 

 

EDO  EDO0 - EDO2  
Effective Point Data 

2 (Operate) 

 

PCLR  PCLR0 - PCLR2 ━ Point Data Clear *2) 

EPLR  EPLR0 - EPLR2 ━ Point Data Clear2 *2) 
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Device Bit Word Double word Description Remarks 

SAXS 
 SAXS00 - SAXS1B  

SCARA Axis Status 

(WORK) 

*1) 

SAXSD 
 SAXSD00 - SAXSD1B  

SCARA Axis Status 

(TOOL) 

*1) 

CD 
  CD0:00:0 - CD1:31:3 

Coordinate System 

Definition Data 

*1) 

SD 
 SD01:00 - SD255:10  

Simple Interference 

Check Zone Data 

*1) 

SACM 

  SACM00 - SACM0D 

SCARA Absolute 

Coordinate 

Movement 

*2) 

SRCM 

  SRCM00 - SRCM0D 

SCARA Relative 

Coordinate 

Movement 

*2) 

SPNM 
 SPNM0 - SPNM6  

SCARA Point 

Number Movement 

*2) 

*1) read only 
*2) write only 
*3) TAG must be on screen during PROG RUN or valid point inquiry 
*4) buffer 
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*Detailed description for device address 

Device Description 

FG FG000:600 

000  >> Progam number    Global area(000), Local area(001~128) 

600  >> Flag number       Global area(600), Local area(900~999) 

INT INT000:0200 

000  >> Progam number   Global area(000), Local area(001~128) 

200  >> Variable number   Global area(200~299,1200~1299), Local area(0001~0099,1001~1099) 

RL RL000:0300 

000  >> Progam number   Global area(000), Local area(001~128) 

300  >> Variable number   Global area(300~399,1300~1399), Local area(0100~0199,1101~1199) 

AXST AXST00 - AXST05: Single-axis status 

00: Axis status 

    Bit 7 (Reserved for system use) 

Bit 6 (Reserved for system use) 

Bit 5 (Push error detection): 0 = Not detected / 1 = Detected 

Bit 4 (Operation command successful completion): 0 = Not yet complete/ 1 = Completed successfully 

Bit 3 (Servo): 0 = OFF / 1 = ON 

Bit 1-2 (Origin return): 0 = Not yet performed / 1 = Returning to origin / 2 = Completed 

Bit 0 (Servo axis in use): 0 = Not in use / 1 = In use (moving, etc.) 

01: Axis sensor input status 

Bit 3 (Reserved for system use) 

Bit 2 (Origin sensor): 0 = OFF / 1 = ON 

Bit 1 (Overrun sensor): 0 = OFF / 1 = ON 

Bit 0 (Creep sensor): 0 = OFF / 1 = ON 

02: Axis error code 

03: Encoder status 

Bit 7 (Battery alarm (BA)) 

Bit 6 (Battery error (BE)) 

Bit 5 (Multi-rotation error (ME)) 

Bit 4 (Reserved for system use) 

Bit 3 (Counter overflow (OF)) 

Bit 2 (Count error (CE)) 

Bit 1 (Full absolute status (FS)) 

Bit 0 (Overspeed (OS)) 

04: Current position (L) unit (0.001mm) 

Indicates the lower 16 bits of the current position in Hex. 

05: Current position (H) unit (0.001mm) 

Indicates the upper 16 bits of the current position in Hex. 

AXST06 - AXST11: Double axes status 

... 

AXST42 - AXST47: Eight axes status 

PGST PGST000 - PGST003: Program number 1 status 

000: Status 

Bit 3 (Reserved for system use) 

Bit 2 (Reserved for system use) 

Bit 1 (Reserved for system use) 

Bit 0 (Start): 0 = Not started / 1 = Started 

001: Execution program step number 

002: Program-dependent error code 

003: Error occurrence step number 

PGST004 - PGST007: Program number 2 status 

... 

PGST508 - PGST511: Program number 128 status 
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Device Description 

SYST SYST0: System mode 

0 = Indeterminable / 1 = AUTO mode / 2 = MANUAL mode / 3 = Slave update mode / 4 = Core update mode 

1: Critical level system error number 

2: Latest system error number 

3: System status byte 1 

Bit 7 (Reserved for system use) 

Bit 6 (Battery voltage error status) : 0 = No error / 1 = Error 

Bit 5 (Battery voltage low warning status): 0 = No low / 1 = Low 

Bit 4 (Power error status): 0 = Normal / 1 = Error 

Bit 3 (Emergency stop switch status): 0 = No emergency stop / 1 = Emergency stop 

Bit 2 (Safety gate status): 0 = CLOSE / 1 = OPEN 

Bit 1 (TP enable switch status): 0 = ON / 1 = OFF 

Bit 0 (Operation mode switch status): 0 = AUTO / 1 = MANUAL 

4: System status byte 2 

Bit 7 (Reserved for system use) 

Bit 6 (Reserved for system use) 

Bit 5 (Program run status): 0 = Not run / 1 = Running 

Bit 4 (Restart wait status): 0 = Not waiting / 1 = Waiting 

Bit 3 (I/O interlock status): 0 = No interlock / 1 = Interlock 

Bit 2 (Servo interlock status): 0 = No interlock / 1 = Interlock 

Bit 1 (Slave parameter writing status): 0 = Not writing / 1 = Writing 

Bit 0 (Application data flash ROM write status): 0 = Not writing/erasing / 1 = Writing/erasing 

5: System status byte 3 

Bit 7 (Reserved for system use) 

Bit 6 (Reserved for system use) 

Bit 5 (Reserved for system use) 

Bit 4 (Operation mode): 0 = Program mode / 1 = Position mode 

Bit 3 (Reserved for system use) 

Bit 2 (System ready status): 0 = Not ready / 1 = Ready 

Bit 1 (System operation status): 0 = Not operating in AUTO mode / 1 = Operating in AUTO mode 

Bit 0 (Drive-source cutoff status): 0 = Not cut off / 1 = Cut off 

6: System status byte 4, Reserved for system use 

PRG PRG ‘000’ - Program number 

Write Data 0: Program Run Command 

Write Data 1: Program End Command 

Write Data 2: Program Pause Command 

Write Data 3: Program One-Step Run Command 

Write Data other: Program Resume Command 

SV SV0: Command trigger / 1 = Write  

1: Axis pattern 

2: Operation type 

Bit 0 (Servo ON/OFF): 0 = OFF / 1 = ON 

RO RO0: Command trigger / 1 = Write  

1: Axis pattern 

2: End search speed at home return 

3: Creep speed at home return 

ACM ACM0: Command trigger / 1 = Write  

1: Axis pattern 

2: Acceleration unit (0.01G)  

3: Deceleration unit (0.01G) 

4: Speed unit (mm/sec) 

5 - C: Absolute coordinate data unit (0.001mm) 
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Device Description 

RCM RCM0: Command trigger / 1 = Write 

1: Axis pattern 

2: Acceleration unit (0.01G) 

3: Deceleration unit (0.01G) 

4: Speed unit (mm/sec) 

5 - C: Relative coordinate data unit (0.001mm) 

JIM JIM0: Command trigger / 1 = Write  

1: Axis pattern 

2: Acceleration unit (0.01G [for each axis, in %]) 

3: Deceleration unit (0.01G [for each axis, in %]) 

4: Speed unit (mm/sec [for each axis, in %]) 

5: Inching distance unit (0.001mm [for each axis, in 0.001deg])  

6: Operation type 

Bit 3 (Reserved for system use) Fixed to 0 

Bit 1-2 (Jogging/inching coordinate system (SCARA only)): 0 = Base coordinate system 

/ 1 = Selected work coordinate system / 2 = Selected tool coordinate system / 3 = Each axis system 

Bit 0 (Jogging/inching direction): 0 = Negative direction on coordinate axis / 1 = Positive direction on coordinate axis 

PNM PNM0: Command trigger / 1 = Write  

1: Axis pattern 

2: Acceleration unit (0.01G) 

3: Deceleration unit (0.01G) 

4: Speed unit (mm/sec) 

5: Point number 

OSC OSC0: Command trigger / 1 = Write / 4 = Clear 

1: Stop axis pattern 

2: Appended command byte 

Bit 1-7 (Reserved for system use) 

Bit 0 (Specification of output cancellation during interlock on-hold (OUT port) (when all operations are paused) 

/ 0 = Not canceled / 1 = Canceled tentatively 

PD, 

ED 

PD0001:00 

0001  >>  Index of point data (0001~1500) 

00    >>  Point Data (00~12) 

00: Point number 

01: Axis pattern 

02: Acceleration unit (0.01G) 

03: Deceleration unit (0.01G) 

04: Speed unit (mm/sec) 

05: 1st axis position data 

... 

12: 8th axis position data 

PDO, 

EDO 

PDO0: Command trigger / 1 = Write / 2 = Read 

1: Starting point number 

2: Number of point data 

PCLR, 

EPLR 

PCLR0: Command trigger / 1 = Write 

1: Clear starting point number 

2: Number of clear point data 
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Device Description 

SAXS Type : Base coordinate system (WORK) 

SAXS00: Work coordinate system selection number 

01: Tool coordinate system selection number 

02: Common axis status 

03: Axis pattern 

04: Axis status 

05: Axis sensor input status  

06: Axis error code 

07: Encoder status 

08: Current position (L) unit (0.001mm or 0.001deg) 

09: Current position (H) unit (0.001mm or 0.001deg) 

SAXS0A - SAXS0F: Double axes status 

… 

SAXS16 - SAXS1B: Four axes status 

SAXSD Type : Selected work coordinate system (TOOL) 

SAXSD00: Work coordinate system selection number 

01: Tool coordinate system selection number 

02: Common axis status 

03: Axis pattern 

04: Axis status 

05: Axis sensor input status  

06: Axis error code 

07: Encoder status 

08: Current position (L) unit (0.001mm or 0.001deg) 

09: Current position (H) unit (0.001mm or 0.001deg) 

SAXSD0A - SAXSD0F: Double axes status 

… 

SAXSD16 - SAXSD1B: Four axes status 

CD CD1:31:3 

1   >> Type (0~1)  0 = WORK / 1 = TOOL 

31  >> Coordination system definition data number (0~31) 

3   >> Coordinate offset (0~3) 

0: X-axis data 

1: Y-axis data 

2: Z-axis data 

3: R-axis data  

SD SD01:00 

01  >> Simple interference check zone data number (01~255) 

00  >> Simple interference check zone data (00~10) 

00 – 08: Simple interference check zone definition coordinate  

09: Physical output port number or global flag number for output upon entry  

10: Entry error type specification 

SACM 00: Command trigger / 1 = Write  

01: Axis pattern 

02: Acceleration unit (% or 0.01G) 

03: Deceleration unit (% or 0.01G) 

04: Speed unit (% or mm/sec) 

05: Positioning operation type (No SCARA axis disabled) 

06 - 0D: Absolute coordinate data unit (0.001mm) 
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Device Description 

SRCM 00: Command trigger / 1 =Write  

01: Axis pattern 

02: Acceleration unit (% or 0.01G) 

03: Deceleration unit (% or 0.01G) 

04: Speed unit (% or mm/sec) 

05: Positioning operation type (No SCARA axis disabled) 

06 - 0D: Absolute coordinate data unit (0.001mm) 

SPNM 0: Command trigger / 1 = Write  

1: Axis pattern 

2: Acceleration unit (0.01G) 

3: Deceleration unit (0.01G) 

4: Speed unit (mm/sec) 

5: Positioning operation type (No SCARA axis disabled) 

6: Point number 

 


